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Grass Valley’s eDiUS is a powerful nonlinear editing system 
used by countless editors all over the world to produce broad-
cast television, film, multimedia, DVDs, and Blu-ray Discs.

nonetheless, many experienced Avid editors hesitate to jump 
in and discover the fast, powerful, and easy-to-use editing tools 
which eDiUS offers.

there are good reasons to stick with what you know: no time is 
required to learn the tools you already use and it takes effort to 
learn new technologies.

the good news is that the core Media composer and eDiUS 
editing experiences are not just similar — they are almost 
exactly the same!

in fact, Media composer 5 has new features that make it more 
similar to editing with eDiUS than ever before. Many differ-
ences between the systems are only in the colors, button 
designs, or names of tools.

these notes give you everything you need to translate your 
existing Avid editing skills into eDiUS editing skills. You will find 
eDiUS quick and easy to learn, with several features that go 
beyond the tools Media composer offers.

this document is intended specifically for Avid Media 
composer 5 editors and is based on eDiUS 6. However, users 
of any editing system will find this information valuable as a 
quick way of getting to know eDiUS, without long explanations 
of technologies you are already familiar with.

Introduction

About This Overview

to watch three supporting videos for this application note, visit 

http://video.grassvalley.com/video/gvsnapshots/edius_for_avid_editors. 

At that site you’ll find videos entitled “overview,” Get cutting,” and “Key tools.”

Get Cutting

Key Tools

Overview

http://video.grassvalley.com/video/gvsnapshots/edius_for_avid_editors
http://video.grassvalley.com/video/gvsnapshots/edius_for_avid_editors
http://video.grassvalley.com/video/gvsnapshots/edius_for_avid_editors
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eDiUS 6 looks very different compared to Media composer 5 
(Mc5) but the two systems have a lot in common.

Let’s start with what is the same

Both systems have:
Software-only and software+hardware modes•	

Switchable single or dual player/program monitors•	

Standard keyboard shortcuts like “i” for Mark-in and “o” for •	
Mark-out

track patching•	

Sync locks•	

effects applied by drag-and-drop•	

JKl playback•	

Standard 3-point edits•	

Mono or stereo audio tracks•	

native support for multiple video formats•	

Sequence and clip markers (locators in Mc5)•	

timeline-based clip rubber-banding•	

the same standard editing workflow•	

Now let’s look at some differences

Only EDIUS has:
combined video+audio tracks—great for fast editing•	

Dedicated title tracks for graphic and stills media•	

native, real-time support for almost any media format•	

Direct linking between clips and All original media (not just •	
AMA-supported formats)

Bin subfolders•	

A dedicated Source Browser for browsing file-based camera •	
media (like p2)

Separate configuration settings for all effects (no effect •	
editor)

A multi-threaded, batch-encoding file encoder (no need for •	
Sorenson)

A powerful, automated proxy mode (like transcoding but with •	
fewer clicks)

Monitor overlays with Zebra for highlights, shadows, and •	
audio level

no filler—it just doesn’t exist on the eDiUS timeline•	

Separate settings windows, including Application, User, •	
project, and Sequence

A seamless interface, with no wasted space•	

In Summary

the core editing experience is the same, whether you cut 
with Media composer or eDiUS. When editing, you will very 
often find the same functionality you would expect in Media 
composer, plus a little bit more in eDiUS.

Differences and Similarities
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the colors may be different, but the key components of the eDiUS interface should be familiar to you.

Overview of the EDIUS Interface

Asset Bin

Just like Media composer bins but designed like a file browser. 
Bins are called folders in eDiUS and sub-folders work just as 
you would expect—be more organized than ever.

Source Browser

no need for AMA—eDiUS links directly to All media as stan-
dard. the Source Browser lets you view file-based media from 
camera formats like p2 and XDcAM like regular clips. edit into 
a sequence directly or organize them first in a bin.
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Player and record Monitors

Just the same as Source/Record composer monitors in Media composer. these can be set to single or dual mode in the View 
menu.

timeline

Much more similar to Media composer than it first appears, plus dedicated title tracks and combined video/audio tracks. Standard 
modifier keys (ctRl and Alt) provide “yellow” and “red” Media composer editing modes (insert and overwrite in eDiUS).
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EDIUS Button Menus

Many buttons in eDiUS have sub-menus that extend their functionality, indicated by 
a drop-down triangle. the Delete button on the timeline, for example, is also a menu 
containing multiple delete options, including effects and rubber banding.

there’s a small learning curve with these sub-menus but they are well worth the 
time as they give you direct access to options you might need to go hunting in the 
command palette for in Media composer.

timeline Modes

Just as Media composer has the red lift/overwrite and yellow extract/Splice-in 
modes, you set your eDiUS timeline with:

insert/overwrite mode (like Red and Yellow Media composer modes)•	

Ripple mode to leave gaps/not leave gaps when deleting or trimming•	

Group/link mode to maintain or break links between sync source audio and video•	

Snapping mode (like the ctRl/command key in Media composer)•	

Information Palette

like an always-on version of the info 
console command in Media composer, 
combined with a list of any effects 
applied to a selected clip,  plus layouter 
controls for scaling, rotation and ani-
mated 3D picture in picture effects.

Effects Palette

Just like the Media composer effect 
palette but with audio effects included.
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importing media into eDiUS is like the best combination of AMA (with direct access to the original media) and the regu-
lar import process in Media composer.

To import regular ‘whole’ media files, you can:
Double click on a blank space in the right-hand viewing panel of the Asset Bin•	

Right-click on a blank space in the right-hand viewing panel of the Asset Bin •	
and choose Add File...

press ctRl-o•	

click on the open button at the top of the Asset Bin•	

Source Browser

What if you are importing file-based camera media like p2 or XDcAM?

With Media composer, you would set up your media directories as AMA linked bins 
but with eDiUS there is simply no need. 

the eDiUS Source browser is a dedicated window for viewing these kinds of files as 
whole clips.

Drag clips from the Source Browser to the Asset Bin to organize them or add them 
directly to a sequence.

Right-click on your selected media and choose Add and transfer to Bin, or click the 
Add and transfer to Bin button to make a local copy of the media in your project folder 
before importing.

this way you can remove your original media and edit using your selected copies.

Remember, all imported clips behave like AMA clips. if you remove your original 
media files, linked clips will go offline unless you copy them onto your local drive first. 

You can even click on the File menu and choose Add clip... to open media directly in the player monitor for use in a sequence with-
out importing it to the Asset Bin.
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Media composer treats every bin as a separate file on your hard drive. All eDiUS bins are incorporated into a single eDiUS project 
file, making organization a little simpler. 

When you first create a project, you will have just one bin folder, called “root.” this is the start of your media organization. create a 
subfolder by right-clicking on the folder list and choosing new Folder.

the Asset Bin is similar to the Media composer project 
Window.

it can contain multiple bins and has shortcut buttons for 
importing media and generating media like color mattes.

the Asset Bin is designed like an Windows explorer window. 
it has folders, rather than bins, on the left with their contents 
displayed on the right.

You can move folders around just like desktop folders, by dragging and dropping.

Just as with Media composer, you can create multiple copies of clips that link to the 
same media file. in fact,  you can use regular copy and paste commands, including 
ctRl-c and ctRl-V to make duplicates of clips.

eDiUS has a unique search feature that creates persis-
tent Search results folders. to access this feature:

press ctRl-F•	

click on the Search button at the top of the Asset •	
Bin

Right click on the folder panel and choose Search•	
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the search options are similar to the Media composer custom sift options in a bin, but the results can be taken from all bin folders 
in your project. You can achieve a similar result by custom sifting the Media tool in Media composer, but with eDiUS this is inte-
grated into the Asset Bin and remains accessible until you remove it, allowing multiple views of the same media.

You can have multiple concurrent Search folders, making it easy to locate new clips as they are added to your project.

Additional tools

the Asset Bin has a tools menu button with the same contents as the regular tools menu.

You can also press F3 to display a quick search bar that 
searches inside the current bin folder. this is very similar to 
Media composer sifting but is quicker to access.

These special tools include:
Disc Burner: Burns copies of previously created DVD/Blu-ray Disc image files or •	
folders. You can export a sequence directly to DVD/Blu-ray Disc from eDiUS using 
the export menu.

XDcAM eX clip Browser: if Sony’s clip browser is installed, this links to it.•	

eDiUS Watch: creates special watch folders. Media added to these folders is •	
automatically imported to your project.

MpeG tS Writer: creates .m2t HDV transport streams FASt, for output to HDV.•	
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You will recognize most of the standard buttons on the player and Recorder preview Monitor windows. if in doubt, hover your 
mouse over the button to get the tooltip, which gives the name and the keyboard shortcut.

to give users a more natural, analog experience, there are real fast-forward and rewind buttons, as well as the familiar play, next 
frame, and previous frame buttons.

like Media composer, you can set separate video and audio marks on your source 
clips for J cuts and l cuts: just use the sub-menu attached to the Set in or Set out 
point buttons.

Standard keyboard shortcuts like “i” for in point and “o” for out point are the same.

the default eDiUS edit shortcuts are different to Media composer, though they func-
tion the same way:

if you are viewing long clips in the player monitor, 
mark a section with in and out marks, then click the 
expand Focus button to zoom the navigation bar to 
your selection. this makes scrubbing and locating 

clips much easier.

like Media composer, you can click and drag in and out marks 
in the monitor navigator, though there is no need to use the Alt 
modifier key.

As well as the analog style 
Fast Forward and Rewind 
buttons, eDiUS has Shuttle 
controllers. the further you 
drag to the right or left, the 

faster the video will play forwards or backwards—just like a 
physical shuttle controller.

there is also a powerful mouse-gesture control system.

click and drag inside the viewing panel of the player or 
Recorder monitors to get the following results:

Drag left to Right: Mark in•	

Drag Right to left: Mark out•	

Drag top to Bottom: edit into timeline (using track patching •	
and insert/overwrite mode)

Using the right mouse button, if you drag in circles on the 
image, the mouse will behave like a Jog controller, allowing 
very precise analog playback of digital media with smooth, 
natural-sounding audio.

overwrite is  “]” and the insert (splice 
in) is “[.”

Removing all marks is “X.”

these shortcuts can easily be changed 
by visiting the User settings.
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Preview Monitor overlays

the View menu gives access to several types of overlay information you can display on the player and Recorder monitors:
Clip/Device:•	  Displays the current clip name (or video deck preset if when capturing)

Safe Area:•	  Displays the Safe Action and Safe title zones

Center Cross:•	  Splits the screen into four equal sections for layout

Marker:•	  Displays the text of any markers (these are the same as Media composer locators)

Zebra:•	  Just like in-camera zebra, shows highlights and shadows

on-Screen Display

Under the View menu, there is an option to toggle the display of an on-screen Status—and you can choose to display this just on 
your computer monitor or also on your external client monitor.

the Status displays current timecode, playback Status, and Audio level.
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Much of your time as an editor will be spent looking at clips, marking them, and adding them to a sequence.

the good news for Avid editors using eDiUS is that there is almost no difference in functionality, naming, button functions, or 
keyboard shortcuts.

Adding Clips to a Sequence

To Perform a Standard Edit:

1. Double click on a clip in the Asset Bin to open it in the player monitor

2. Add in and out marks by clicking on the Add in point or Add out point buttons or by pressing the “i” or “o” keys

3. Set up your track patching, just as you would with Media composer

4. Set your edit position on the timeline, or use an in mark

5. click on the insert or overwrite button or press the [ or ] key

You can also drag-and-drop directly from the player preview monitor or from the Asset Bin.

What happens when you remove a clip from a sequence depends on the timeline modes—see “Working with the timeline.”

removing Clips from a 
Sequence

To Remove a Clip Segment from a 
Sequence:

Select it

press the Delete key

Moving Clips in a Sequence

Moving clips that are already part of a sequence is the same 
experience in eDiUS as it is in Media composer. like Media 
composer, you will need to choose your mode (insert or 
overwrite).

Since version 5, Media composer has provided the option to 
automatically select audio clips that are linked with video clips. 
this has always been the way the eDiUS timeline functions.

in both edit systems, you prevent this automatic selection by 
using the Alt modifier key. 

the Proxy Workflow

Media composer allows you to transcode media to a highly 
compressed format and then relink clips to the new files for 
increased performance, relinking to the original media later for 
output.

eDiUS offers the same functionality, including a standard-
definition downconvert for HD media, but there is also a fully 
automated proxy mode.

When you turn on proxy mode, eDiUS automatically creates 
highly compressed copies of all your project media and links all 
Asset Bin clips and sequence clips to the new files.

the conversion is a background process, so you can continue 
editing while it happens and you will know when a clip has 
been converted as proxy clips have a patterned texture on the 
timeline.

Working in proxy mode dramatically reduces workload for your 
cpU, which is useful when editing on a less powerful computer 
like a laptop.

toggle between proxy mode and regular editing mode at any 
time, by clicking on the Mode menu and choosing proxy Mode.

or

Right click on it and choose Delete 
(Media composer lift) or Ripple Delete 
(Media composer extract)

or

click on the Delete short-
cut button at the top of 
the timeline

or

Use one of the timeline Delete button 
submenu options to choose a different 
delete type or partial delete
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the core editing tools and functions you are used to in Media 
composer are available in eDiUS, though sometimes with dif-
ferent names and different button designs.

let’s look at the key options:

timeline Modes

You will be familiar with the eDiUS insert and overwrite 
modes, as Media composer extract/Splice-in and lift/overwrite 
modes.

eDiUS also has a Ripple Mode and Group/link mode:

Toggle Insert/Overwrite mode: the same 
as Media composer—in overwrite mode, 
clip segments overwrite other clips on the 
timeline; in insert mode, clip segments 
shuffle around each other non-destructively.

Set Ripple Mode: this applies different 
timeline behavior when you are in insert 
mode—the options do not apply if you are 
in overwrite mode.

if Ripple mode is on (when you are in insert mode), reduc-
ing the duration of a clip by trimming will cause other clips to 
move. if Ripple mode is off, eDiUS will leave a gap instead.

if you delete or move a clip segment with Ripple mode on, 
other clips will move to fill the gap. if you turn Ripple mode off, 
eDiUS will leave a gap.

like Media composer, the result will also be affected by your 
sync locks.

Set Group/Link Mode: enables or 
disables the automatic selection of linked 
video and audio segments. this is the 
same as the new link Selection toggle in 
Media composer 5.

Snap to Event: Media composer snaps 
to clip edges when you use the ctRl key. 
eDiUS achieves a similar result with the 
Snap mode.

track Patching

eDiUS and Media composer both use 
track patching to position clips that are 
edited into a sequence. there are per-
haps two minor differences:

eDiUS will add patched clips to a 
sequence even if the track header is 
turned off, while Media composer 
requires the track headers to be turned 
on. You can disable parts of a source clip 
by turning individual source buttons off.

eDiUS allows you to toggle source audio 
between stereo and dual mono modes 
on the timeline, without needing to 
change clips in the Asset Bin.

to toggle the mode, right click on the 
source audio button and choose Audio 
Source channel.
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Sync Locks

these behave exactly as you would expect, based on your experiences of Media composer. You can toggle all sync locks 
on and off by clicking on the Sync lock toggle at the top of the track header buttons.

track Headers

eDiUS has controls for displaying or hiding audio waveforms on each track.

the options available can vary because eDiUS supports several kinds of tracks:
Audio•	

Video•	

title•	

Audio/Video•	

You can add or delete tracks by right clicking on any of the track header buttons.

About Clip Segments

in the same way that Media composer displays video and audio segments in different 
colors, eDiUS keeps video, audio, and mixer (opacity/alpha) parts of sequence clip 
segments separate.

Media composer will not allow you to combine video and audio on a single track, so it 
is simple to see what kind of media you have in a sequence.

eDiUS allows you to combine all media types on special Video/Audio tracks. this 
makes it very clear which audio is associated with which video but can confuse new 
users who are not familiar with Video/Audio tracks.

the Video, Audio, and Mixer parts of clips, all have different appearances. the Mixer 
part clip always appears where there is video. it allows rubber-banding of clip opacity 
(think of the Media composer Superimpose effect).

the mixer is only visible when you click the expand triangle on the track header to 
show it.
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trimming with Media composer 5 is more similar to trimming with eDiUS than previ-
ous versions.

to apply single or dual roller trims directly, simply click and drag. to trim multiple clips, 
lasso to select them and then click and drag.

to apply a complex multi-clip trim, hold down the ctRl key to apply multiple trim 
handles.

to use the dedicated trimming window, with controls similar to the trimming mode in 
Media composer, double click on a clip handle. You can do this without first selecting 
a handle—just double click the clip handle you want to trim.

the trimming mode window has standard controls as you would expect, including 
shortcuts for standard trim types like slip and slide. if in doubt, hover the mouse cur-
sor over a button and the tooltip will tell you the trim type.

the eDiUS title tool is very similar to the Media composer title tool but it has a few more options.

Both the Media composer title tool and eDiUS Quick titler use object selection in the same way.

Use the text tool to create text or a shape tool to create a shape. 

Use the Select tool to move what you have typed or created.

When you select an item you have created, the properties panel displays options for that object.

Along the bottom of the title tool, there are several standard title styles. Apply a style by double clicking on 
it.

to create a new style, set up your text or graphic as you want it and right click inside the Style Bar to 
choose Save As new Style.

if you select the background, or no object (no text or graphics), the properties panel will display the title 
properties. this allows you to set the title as a still, roll or crawl or add a background image.

the trimming mode window appears in place of the preview monitors.  When in trimming mode, you will see two “X” close but-
tons on the window. the top right corner “X” will quit eDiUS.

the larger “X” at the bottom closes the trimming window and returns you to the preview monitors.

You can also toggle in and out of trimming mode by pressing F6.

the eDiUS title tool operates in low resolution to maximize responsiveness. to see a finished quality version of your 
title, click the preview button at the top of the window or press F3.

Unlike Media composer, where graphic media is treated like still video, with a finite duration, graphic media in eDiUS 
has a theoretically infinite duration. the default duration is set in the User settings but you can trim to any length you 
like.
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Drag-and-drop transition effects in eDiUS function exactly as they would in Media composer.

to apply a transition effect to multiple clips, lasso to select them and drag-and-drop the effect you want, as usual.

Set the timeline position slider near an 
edit and press ctRl-p to add the default 
transition on the selected track.

eDiUS allows you to adjust the duration 
of transitions just as you would adjust 
the length of a clip segment—by trim-
ming. Simply click and drag one end of 
a transition on the timeline to adjust the 
duration.

there are options in the User settings 
that tell eDiUS whether or not to auto-
matically add an audio crossfade when 
you add a video transition.

Removing a transition is simply a ques-
tion of selecting it and pressing Delete.

You access individual settings (including 
keyframing) for transitions by select-
ing the transition you want and double 
clicking on its entry in the information 
palette.
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Adding, working with, and removing effects is essentially the same in eDiUS as it is in Media composer. As with so many of the 
differences between the systems, they are most often aesthetic.

Adding Effects

When you add an effect by dragging and dropping it onto a clip segment, be sure to 
drop the effect onto the correct part of the clip.

Video effects should be added to the video part of a clip•	

Audio effects should be added to the audio•	

Keying or blending effects should be added to the Mixer part of the clip•	

the separation of the video, audio, and mixer parts of clips also applies when look-
ing for effect settings. the information palette shows effects that are applied to the 
selected part of the clip.

this sometimes confuses new eDiUS editors, particularly when working with com-
bined Video/Audio tracks, where a clip behaves like a complete clip on a single track.

if you select a clip and effects you have applied do not show up in on the information 
palette, double check you have the correct part of the clip selected. A blue outline 
appears on the selected part of the clip.

Color Correction

eDiUS does not use a special color correction mode in the way that Media composer 
does, though it offers similar tools and functionality.

color correction effects are applied like any other—by dragging and dropping the 
chosen effect from the effect list.

A Vectorscope and Waveform are available at any time—not just when 
color correcting—by clicking on the Vectorscope/Waveform button at the 
top of the timeline or by selecting Vectorscope/Waveform on the View 
menu.

Combining Effects

it is not necessary to nest effects in eDiUS as it is in Media composer. to com-
bine multiple effects, drag them onto a clip and you will see them as a list on the 
information palette.

You can enable and disable individual effects by clicking on the effect tick box on the 
information palette.

You can change the order effects are applied, like Media composer, by dragging and 
dropping to move them up or down the list.
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the Layouter

Media composer uses several kinds of effects to apply adjustments to clips like reframing or picture in picture. eDiUS also has 
effects that can be used this way, including a dedicated picture in picture effect.

in addition, eDiUS has advanced layouter controls for every clip.

the layouter gives 2D and 3D control over clip appearance that can be fully keyframed. it is a powerful tool, especially when 
combined with video filter effects like the track Matte and Mask, which can selectively mask regions of video or apply effects to 
regions.

if you are familiar with cropping, position, rotation and color selection controls, you will enjoy using the layouter.

there are just a small number of features you may not be familiar with already.

the layouter has a 2D and a 3D mode. You switch between these modes by clicking on the appropriate but-
ton at the top of the window.

You can switch the units of measurement between percentages and pixels by clicking on the “%” or “px” button 
at the top right of the layouter window.

You can apply the effects and effect settings from one clip to another clip (or multiple clips). You can do this by dragging the effect 
straight from the information palette to another clip.

to use keyframing, put a tick in the box 
for each setting you wish to keyframe.

You can also tick the “layouter” box at 
the top to turn on keyframing for every 
setting.

if you expand an 
individual keyframe 
setting, you will find 
keyframe controls 
very similar to those 
found in the advanced 
keyframe panel of 
Media composer.
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Media composer 5 uses a combination of several tools to apply audio level keyframes, display current master volume, and add 
audio effects.

each track shown in the Audio Mixer has the following modes:
track: Adjusts overall level for the whole track.•	

clip: Adjusts overall level for the current clip.•	

off: Makes no new changes to audio level, though the mixer will still display audio level for the •	
track.

latch: this is the way the Media composer audio mixer records audio level keyframes. if audio •	
level keyframes exist, the fader will animate, following them. When you take control of the fader, 
new replacement keyframes are added. When you release the fader, it stays where you leave it, 
overwriting existing keyframes with the new level until you stop playback.

touch: Follows existing audio keyframes just like latch mode. However, when you release the fader •	
after applying an adjustment, it will go back to following existing keyframes, rather than overwriting 
them.

Write: Does not follow existing keyframes at all. With this mode you can set the fader before you •	
begin and when you press record, existing keyframes will be ignored and overwritten.

eDiUS even allows you to set a new Master output volume to make last minute adjustments to overall output level.

Adding Audio filters

Audio filters are applied and adjusted like any other effects in eDiUS—find the effect you want in the effect palette and drag-and-
drop to apply it. Always be sure to drop the effect onto the Audio part of the clip segment or it won’t be applied.

eDiUS 6 has an Audio Mixer that is very similar to 
the equivalent in Media composer, accessed by 
clicking on the View menu and choosing Audio Mixer 
or by clicking on its button at the top of the timeline.

While most of the options will be familiar to you, unless you also 
use an audio editing system, you may not be familiar with the 
latch/touch/Write modes the eDiUS audio mixer includes for the 
live creation of audio rubber banding—audio keyframes.
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the export button menu at the bottom right corner of the Recorder preview monitor has all of the output options you might need 
to play out to tape or export your sequence to a file, DVD, or Blu-ray Disc.

the same export options are also under the File menu.

output to tape

if you want to crash record, you can usually 
simply hit record on your video deck and play  
your sequence because eDiUS always plays 
sequences and effects at full quality.

if you choose “print to tape” or “print to tape 
(Display timecode)...” which burns in timecode, 
you can use regular deck controls to mark a cut 
point on your tape and frame accurately insert 
edit.

Batch Export

if you select “Add to Batch list” rather than 
“export,” eDiUS will add the job to the Batch 
export window, which you also access under the 
export menu.

eDiUS will not begin processing the Batch of 
encoding jobs until you manually tell it to.

the Batch export window has buttons to add 
extra jobs, allowing you to quickly build a list of 
output versions.

one major difference between eDiUS and Media 
composer is the lack of Sorenson Squeeze or 
any other third-party encoding application. this is 
because eDiUS already has advanced encoding 
features built in.

output to file

“print to File...” brings up the print to File win-
dow, with a wide range of media formats you 
can export to. the settings that apply to each of 
the presets should be familiar to you.

the advanced settings, along with many addi-
tional presets, are unavailable until you tick the 
enable conversion box, which allows eDiUS to 
change the frame rate and frame size.

if you tick the Display timecode box, eDiUS will 
burn timecode into the output automatically—
very useful for client review. note: you change 
the start timecode for your sequence in the 
sequence settings.
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output to DvD/Blue-ray Disc

eDiUS has a comprehensive integrated DVD/Blue-ray Disc authoring application called Disc Burner, accessed by clicking on the 
export menu and choosing “Burn to Disc...”

You can create single-layer and dual-layer DVDs and Blu-ray Discs, straight from the timeline, without creating any intermediary 
files for a separate DVD authoring application.

if you simply want to burn a disc with your current sequence, go to the Write tab and click on 
create Disc. eDiUS will burn the DVD/Blue-ray Disc with an automatically generated menu that 
links to your sequence.

note that the Movie tab has an “Add File” button, to 
browse to a media file and include it on the disc. “Add 
Sequence” allows you to choose any combination of 
sequences in your current project for inclusion.

clicking on the “Setting” button for a movie title, under the Movie tab, gives access to the encoding settings.

the Style tab has a significant number of prebuilt menu designs to choose from. Use the tabs at the bottom of the window to 
browse them. Whichever style you choose, eDiUS automatically links buttons and add text based on your project and sequence 
names.

the edit tab allows you to apply detailed adjustments to the menu designs.

Under the Write tab, there is a tick box to “enable Detailed” settings. these include the option to create a disc image (you can use 
the Disc Burner under the eDiUS tools menu to create multiple copies of an existing image).
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the standard settings are likely to allow you to jump in and get 
to work with eDiUS. it is likely your system has already been 
configured, with shortcuts to any connected video decks you 
will use and storage drives organized and ready to use.

Under the System Settings, you will find the User profile 
management options. this allows you to create multiple user 
profiles, export and import them (export and import by right 
clicking on the profile entries). to change the current profile, 
choose “change profile...” on the Settings menu.

User settings give many detailed options to tweak and tune 
eDiUS to operate exactly as you want it to. note, in particular, 
the User interface category, that includes Button and Keyboard 
Shortcut options.

eDiUS allows you to switch project settings at any time, and to 
keep multiple user-defined presets ready to hand, so you can 
toggle between different resolutions. Use the project settings 
to choose a different preset or make specific changes to the 
current settings.

project presets are created in the System Settings.

the core eDiUS editing experience is very similar to editing with Media composer and the latest version of Media composer adds 
features and functionality that more closely align it to the eDiUS editing experience.

once you get used to the buttons being different colors and the new naming conventions, you will find everything you know about 
editing in Media composer is still useful in eDiUS.

Many experienced Avid editors fall in love with the speed and ease of use eDiUS gives.

the best way to build your confidence is to start cutting... Happy editing!

For further information about eDiUS, Grass Valley hardware and software, and further training, visit www.grassvalley.com.
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